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Overview 
This document is a compilation of the release notes distributed for the enhancements made in Costpoint, 
Budgeting and Planning, and Time & Expense in July 2018. This document includes descriptions of the 
enhancements in relation with system jars, application jars, libraries, and regulatory updates since the last system 
jar release. 

Note: Release notes contain summaries of the enhancements made. Refer to the online help for additional details.  

          Costpoint 7.1.1 Online Help 

http://help.deltek.com/Product/Costpoint/7.1.1/GA/costpoint_help.htm
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Platform Changes 
Costpoint 7.1.1 SQL Server 2017 Compatibility 
Costpoint 7.1.1 is updated to support SQL Server 2017. 

System Requirements 
This enhancement requires the following: 

 DeltekCostpoint711ApplicationTier_Build05.1.exe 

 DeltekCostpoint711Collation_Build05.1.exe 

 DeltekCostpoint711DatabaseTier_Build05.1.exe 

 DeltekCostpoint711WebTier_Build05.1.exe 

New Costpoint 7.1.1 User Interface 
Costpoint 7.1.1 has a new modern and intuitive user interface (UI) with many enhancements.  

 

Changes to the Desktop 
Improved User Interface and Navigation 
The new UI streamlines navigation and provides an improved user experience. Some of the updates include: 

 A new Login screen with the option to use the new UI or the classic view. 

 A responsive layout and optimized screen size. 

 Modernized menus, toolbars, and icons. 

 Redesigned lookup, query, messages, and dialog windows. 

For more information: 

 View a Walkthrough of Costpoint’s new UI. 

 Learn how to navigate the new UI in the Costpoint Navigation video. 

https://help.deltek.com/PRODUCT/COSTPOINT/USS/NEWCOSTPOINTUSERINTERFACE/
http://help.deltek.com/Product/Costpoint/USS/GettingStarted/Navigating
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 Refer to the Getting Started Guide for detailed descriptions of updated icons, dialogs, menus, and toolbars. 

 Refer to the Deltek Costpoint 7.1.1 New UI FAQs for common questions about the new UI. 

 Read Knowledgebase article #94430 to learn about the upcoming updates for Time and Expense 10. 

The quick reference cards or QRCs found in the online help have also been updated to align with the new user interface. 

 Query and Lookup QRC 

 Setting Up Printers QRC 

 Shortcut Keys, Toolbar Icons, and Buttons QRC 

 Views QRC 

The User Interface click-thru is also available to give you more information about the new Costpoint user interface. 

Changes to the Mobile View 
The new UI is also available in the Costpoint mobile view. 

     

System Requirements 
This enhancement requires the following: 

 cp711_sys_043.zip 

 

 

https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=469556C0-7855-419A-A2EA-681E842A97C2
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=8344FAE4-8C63-485E-AC70-04AB989C078E
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=090F3799-7190-4E8B-B410-69DE0DD920E7
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=0C1FD518-9BC8-44B4-95CD-B42D6106C68F
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=7B220DB7-499A-44A7-B357-7F72CA4EBF46
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=2820EB22-7E98-4065-89CE-EC228062F259
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=29A58058-9399-40A7-B617-A96EF5EB7051
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=0CA4F657-1A6A-4955-948F-A8595C5E6E70
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Installation Instructions 
Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before applying this 
update, consider whether you have any custom programs or reports in the application area affected by the update. If so, 
contact Deltek Support Center at https://deltek.custhelp.com before you install the update. 

To Download the HotFix/Feature Update: 
1. From Internet Explorer, go to https://dsm.deltek.com. 

2. Click Run Deltek Software Manager. 

3. Log in using your Deltek Support Center credentials. 

4. In the left pane of the Deltek Software Manager, expand your Deltek product. 

5. Expand the Hot Fixes folder for your product, and select the update to download. 

6. Click Download at the bottom of the screen. 

To Install the HotFix/Feature Update: 
Refer to the installation instructions posted on Deltek's Support Center site, https://deltek.custhelp.com. 

 For Costpoint 7.1.1 updates, refer to Knowledge Base article 79232. 

 For Costpoint 7.0.1 updates, refer to Knowledge Base article 73769. 

 For Costpoint 7.0 updates, refer to Knowledge Base article 67722. 

Before you install this update, please review all previous updates in the Knowledge Base article. You may need to install 
prerequisite programs or database patches (described in the Knowledge Base article) prior to installing this update. Note 
that when you download an update using Deltek Software Manager (DSM), all dependent files are automatically 
downloaded. 

To Check to See if the HotFix is Installed: 
1. Open the application that was updated. 

2. Click Help > About Costpoint from the Costpoint toolbar. This will display a screen that shows you the latest 
update JAR for the application that is open, as well as the latest system JAR and all patches applied to the 
system. 

To Check to See if the Feature is Installed: 
1. Click Help > About Costpoint from the Costpoint toolbar. 

2. Open the Features subtask and click the Feature that was just installed. 

3. Open the Applications subtask. Check the list of applications and their corresponding application jars and see if 
they are correct and have been successfully deployed (highlighted in green). 

4. Open the Patches subtask. Check the list of patches and see if they are correct and have been successfully 
deployed (highlighted in green).  

Note: Most of the features installed have their corresponding patches, but not all. 

https://deltek.custhelp.com/
https://deltek.custhelp.com/
https://dsm.deltek.com/
https://deltek.custhelp.com/
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More Information: 
If you have any questions, please contact Deltek Support Center at https://deltek.custhelp.com 

https://deltek.custhelp.com/
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Costpoint 
Accounting 
There are no changes to the Accounting domain for this release. 

Contracts 
Patch 3466 
PATCH3466 has been released in preparation for the future enhancements for the Manage Opportunities, Configure 
Opportunity Settings, Manage Opportunity Stages, and Manage DFARS Library screens. 

Patch 3467 
PATCH3467 has been released in preparation for the future enhancements for the Configure Opportunity Settings 
screen and for an upcoming new screen in the Contracts domain. 

Contract Management Video and Click-Thrus 
The Contract Management Overview video has been updated to reflect the new UI and the change from the Contract 
Management module to the new Contracts domain. See the latest video through this link: Contract Management 
Overview. 

Click-thrus have also been created to give you an overview about the main areas in the Contracts domain and assist 
you as you work with these areas. Use the following links to access the click-thrus: 

 Opportunities Overview Click-Thru 

 Organizational Conflict of Interest Overview Click-Thru 

 GovWin IQ Integration Overview Click-Thru 

 Contracts Overview Click-Thru 

 Subcontracts Overview Click-Thru 

 Customer, Vendor, and Employee Overview Click-Thru 

Projects 
There are no changes to the Projects domain for this release. 

People 
Allow Updating of Organization IDs on Job Templates  
This Costpoint release will allow you to modify the Organization IDs on existing job templates. In order to implement the 
enhancement, the Organization ID will no longer be the primary key of job templates. 

Screen Updates 
The release updates the following screens for this enhancement:  

Approve Position Requisitions (HPMAREQ)  

 The organization ID was removed from the primary key of job templates.  

 A new Original ID field displays the original job template ID. This field will only be populated if there was 
previously another record in the table with the same ID.  

https://help.deltek.com/Product/Costpoint/USS/Projects/ContractManagementOverview/
https://help.deltek.com/Product/Costpoint/USS/Projects/ContractManagementOverview/
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=37755D44-EE66-4848-A1FF-313C1ACDFE67
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=BD87EA0C-88A8-407C-829D-56F069B514EE
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=981075FB-839A-446A-B7B4-E62CE66ABCC9
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=0AFBABB3-666D-4D47-9D3F-BAFA8337C54D
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=1F143A39-2239-4EF9-A5DE-0A23A6F00331
https://dsm.deltek.com/DeltekSoftwareManagerWebServices/downloadFile.ashx?documentid=C1076480-FD1E-43BB-909D-765DC447326B
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 When you use the Query function, the Find and Query tab now allows you to search for job templates using the 
Original ID field.  

Configure Personnel Settings (HPMSET)  
A new Require Org ID check box allows Deltek Talent Management users to either require or not require the 
Organization ID on the job templates for a company.  

Note: This check box is enabled only when you have a Deltek Talent Management license. If you opted to clear the 
Require Org ID check box, and then you stopped using Deltek Talent Management, you must manually select this check 
box to require organization IDs on job templates. 

Manage Employee Information (LDMEINFO)  
When creating employees through SilkRoad or Talent Management, and when searching for a job template, the 
application uses the original ID for the job template as the job template ID. If the original ID does not exist, the 
application uses the job template ID.  

Manage Job Templates (HPMREQR)  
The following are updates to the Manage Job Templates screen:  

 The organization ID was removed from the primary key of job templates.  

 The Organization ID field can now be edited.  

 A new Original ID field displays the original job template ID. This field will only be populated if there was 
previously another record in the table with the same ID. 

The company ID is now part of the primary key of job templates. Previously, the application performs a 
validation to ensure that each job template ID was unique to a company ID.  

Setup Company (SYPCOMP)  
When you create a new company, the application applies a default value of Y to new Require Org ID field on the 
Configure Personal Settings application (HP_PER_ADM_SETTINGS.ORG_REQ_FL).  

Transfer SilkRoad Data (LDPSRDAT)  
When searching for an existing job template ID (H_POS_RQ_RQST.RQ_NO), the application determines if it exists for 
the employee’s company. If not, the application searches the Original ID field (H_POS_RQ_RQST.ORIG_RQ_NO).  

When transferring the job template information to SilkRoad, if data exists in the Original ID field, the application sends 
that ID number instead of the job template ID.  

Transfer Talent Management Data (EMPHRSDAT)  
When searching for an existing job template ID (H_POS_RQ_RQST.RQ_NO), the application determines if it exists for 
the employee’s company. If not, the application searches the Original ID field (H_POS_RQ_RQST.ORIG_RQ_NO).  

When transferring the job template information to Deltek Talent Management, if data exists in the Original ID field, the 
application sends that ID number instead of the job template ID. 

Known Issue  
Newly Created Company Inherits the Auto-Approve Position Requisition Value of Login Company  
Deltek Defect Tracking Number: 967206  

Description: When you log in to Costpoint using a company with a default approver on the Configure Personnel 
Settings screen (the Auto-Approve Position Requisitions check box was selected and a valid Default Requisition 
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Approver was specified), and then you create a new company, the created company inherits the login company's Auto-
Approve Position Requisitions (REQ_AUTO_APPRVL_FL) column value in the H_PER_ADM_SETTINGS table.  

Customers Impacted: This defect affects Costpoint Personnel users.  

Workaround Before Fix: Set up an approver on the Manage Position Requisition Approvers screen, and then use the 
approver on the Configure Personnel Settings screen.  

Additional Notes: None. 

System Requirements  
This enhancement requires the following Costpoint 7.1.1 releases:  

 PATCH3381  

 Common Lib - LDMEINFOLIB (cp711_cmnlib_LDMEINFOLIB_006.zip)  

 

Application JAR Requirements  
The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR version for 
each application, if applicable. 

Domain Module Application ID Application Name Application File 

Administration  System 
Administration  

SYPCOMP  Setup Company  cp711_sypcomp_021.zip  

People  Employee  EMPHRSDAT  Transfer Talent 
Management Data  

cp711_emphrsdat_015.zip  

People  Employee  HPMREQR  Manage Job 
Templates  

cp711_hpmreqr_012.zip  

People  Employee  LDMEINFO  Manage Employee 
Info  

cp711_ldmeinfo_022.zip  

People  Employee  LDPSRDAT  Transfer SilkRoad 
Data  

cp711_ldpsrdat_011.zip  

People  Personnel  HPMAREQ  Approve Position 
Requisitions  

cp711_hpmareq_003.zip  

People  Personnel  HPMSET  Configure 
Personnel Settings  

cp711_hpmset_003.zip  

 

Regulatory and Compliance 
IMPORTANT NOTES 

Warning: Unless specifically noted in the release notes, any future federal and state tax table changes (not just 
Colorado) will require the following: 

System JAR 054 for Costpoint version 7.0.1 

System JAR 028 for Costpoint version 7.1.1 
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Versions 7.0.1 and 7.1.1 - Calendar Year End 2018  
In an effort to allow adequate time to prepare for future year-end system jar requirements, please be aware that you 
must have the following System JARs loaded before the Calendar Year End 2018 release which is scheduled for 
December 2018. Appropriate action should be taken throughout the next months to plan for this System JAR 
requirement. 

Anticipated Calendar Year End 2018 System JAR Requirements  
 Costpoint 7.0.1: System JAR 054 (to be released June 2018)  

 Costpoint 7.1.1: System JAR 028 (released April 2017)  

Notes: 

System JAR 054 for Costpoint 7.0.1 introduced an update to the Colorado state tax withholding tables. In response to 
the federal tax code overhaul (Pub. L. 115-97), the Colorado Department of Revenue announced an update to their 
Allowance table on April 2, 2018 (effective April 1, 2018). This required an update to Costpoint Compute Payroll, which 
can only be released through a System JAR in Costpoint version 7.0.1.  

System JAR 049 for Costpoint 7.0.1 and System JAR 028 for Costpoint 7.1.1 introduced a much needed change to 
the State Filing Statuses in Costpoint. Rather than using filing statuses that only applied to Costpoint (Both, 
Miscellaneous 1, Miscellaneous 2, etc.) and had to be manually mapped to each state’s actual filing statuses, Costpoint 
7.0.1 and 7.1.1 have been updated to use each state’s actual filing status(es). Though the new filing statuses were 
introduced in April 2017, Deltek will continue to support tax table updates based on the original state filing statuses for 
the remaining 2018 tax updates. Any tax updates for 2019 will only support the new state filing statuses that were 
introduced in System JAR 049 for 7.0.1 and System JAR 028 for 7.1.1 (both released in April 2017). 

Version 7.1.1 – Further Reductions in the Need to Release Regulatory Updates within System JARs  
We are happy to announce that we have made several programming changes within the past year to limit the need for 
regulatory changes to be released via System JAR. System JAR 028 for Costpoint 7.1.1 was part of that effort. The 
coding changes introduced in System JAR 028 for Costpoint 7.1.1 allowed us to disassociate payroll computation coding 
changes from future 7.1.1 System JAR releases. So, after System JAR 028, changes to Costpoint version 7.1.1’s 
Compute Payroll application will not require deployment via System JAR as they did in the past. This means that we can 
deploy Costpoint 7.1.1 regulatory updates and fixes more quickly, and help us keep the System JAR requirements for 
Calendar Year End releases as minimal as possible. 

The changes we made with the noted System JARs will greatly help with that effort to minimize the System JAR 
requirements for future regulatory releases. 

2018 New Mexico Withholding Tax 
This release updates Costpoint to support the following changes to the New Mexico withholding tax: 

 The State’s tax brackets were updated. 

 The amount per allowance increases from $4,050 to $4,150. 

 When calculating New Mexico state tax withholding for an employee, if that employee claims more than three 
allowances on his/her W-4, only three of the allowances will be applied. 

Note: In order to apply this change, New Mexico exemption amounts were moved from the Manage State Taxes screen 
to the Manage State Tax Withholding Adjustments screen where the transferred exemptions have an exemption type of 
Personal Exemption Allowances in the Type field. 

System Requirements 
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Warning: You must install the following before installing PATCH3486: 

System JAR 028 

PATCH3374 — New York, Ohio and Wyoming SUTA Wage Base 

PATCH3385 — Virgin Island SUTA Wage Base/Oregon and Virgin Island State Tax 

PATCH3396 — Add State Filing Status of Exempt 

PATCH3401 — Louisiana Withholding Tax 

PATCH3459 — Utah and Idaho State Tax 

PATCH3465 — Colorado State Tax 

If you attempt to install patches 3374, 3385, 3396, 3401, 3459, and 3471 after installing the May 2018 Colorado tax 
table update (PATCH3465), the state updates will not be properly implemented. 

2018 Q3 July SUTA Electronic Filing Updates  
This Costpoint release includes enhancements to support the 2018 SUTA electronic filing updates of Alaska and Florida.  

Alaska  
The State of Alaska updated the Occupational Coding Manual for 2018. This release updates the Costpoint database 
tables for Alaska Geographic Code (S_AK_GEO_CD) and Alaska Occupational Code (S_AK_OCC_CD) to reflect the 
2018 coding changes.  

This release also adds new validations on the Create Quarterly SUTA Tax File (PRPSMM) screen to ensure that there 
are no invalid or missing codes when you create the tax file for Alaska.  

Florida  
The Florida Department of Revenue released an updated reemployment tax specification (Schema v2018 1.0) last 
March 2018. In order for Costpoint to be compliant with Florida's requirement, this release updates the Create Quarterly 
SUTA Tax File screen to use the latest XML Schema for the State of Florida.  

System Requirements  
This enhancement requires Costpoint 7.1.1 PATCH3436.  

Application JAR Requirements  
The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR version for 
each application, if applicable. 

Domain Module Application ID Application Name Application File 

People Payroll PRPSMM Create Quarterly 
SUTA Tax File 

cp711_prpsmm_022.zip 

 

Materials Management 
Organizational Security - Inventory 
The Organizational Security feature enhances the secure functionality of Costpoint by warranting proper user access 
throughout the Materials domain, specifically in the Inventory module. This feature ensures that correct user access is 
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applied to the logged-in user ID in accessing inventory transactions by validating and filtering records/transactions as 
authorized for the user ID. 

Patch and System JAR Requirements 
These enhancements require the following: 

 Costpoint 7.1.1 System JAR 043 (cp711_sys_043.zip) 

 PATCH5110 

 PATCH5121 

 PATCH3390 

 PATCH3397 

 PATCH3405 

 PATCH3483 

Application JAR Requirements 
The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR version for 
each application, if applicable.. 

Domain Module Application Name Application 
ID 

Application Files 

Materials IN Configure Inventory 
Accounts 

INMACCT cp711_inmacct_003.zip 

Materials IN Configure Default 
Project Inventory 
Accounts 

INMWACCT cp711_inmwacct_003.zip 

Materials IN Manage Inventory 
Projects 

INMPROJ cp711_inmproj_010.zip 

Materials IN Enter Cost 
Adjustments 

INMCSADJ cp711_inmcsadj_006.zip 

Materials IN Enter Inventory 
Transfers 

INMPAXFR cp711_inmpaxfr_015.zip 

Materials IN Manage PO/Req 
Inventory 
Reservations 

INMPORSV cp711_inmporsv_008.zip 

Materials IN Create Inventory 
Abbreviations 

INPALLOC cp711_inpalloc_004.zip 

Materials IN Enter Issues to 
Project/Account/Org or 
PO 

INMPAISS cp711_inmpaiss_020.zip 

Materials IN Enter Scrap 
Adjustments 

INMSCADJ cp711_inmscadj_012.zip 

cp711_cmnlib_INMADJLIB_001 

Materials IN Enter Quantity 
Adjustments 

INMQTADJ cp711_inmqtadj_012.zip 
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Domain Module Application Name Application 
ID 

Application Files 

cp711_cmnlib_INMADJLIB_001 

Materials IN Enter Location 
Transfers 

INMLOXFR cp711_inmloxfr_010.zip 

Materials IN Create Mass Inventory 
Transfers 

INPMSXFR cp711_inpmsxfr_010.zip 

Materials IN Manage Inventory 
Requests 

INMRQST cp711_inmrqst_001.zip 

cp711_cmnlib_INMRQSTLIB_001 

Materials IN Manage Inventory 
Reservations 

INMPARSV cp711_inmparsv_001.zip 

cp711_cmnlib_INMRQSTLIB_001 

Materials IN Print Purchase Price 
Variance Analysis 
Report 

INRPPV cp711_inrppv_002.zip 

Materials IN Create Purchase Price 
Variance Journal Entry 

INPPPV cp711_inppppv_002.zip 

Materials IN Print Inventory 
Reorder Report 

INPREORD cp711_inpreord_014.zip 

Materials IN Print Inventory 
Transaction History 

INRHSTPA cp711_inrhstpa_004.zip 

Materials IN Load Organization IDs INPLDORG cp711_inpldorg_001.zip 

Materials IN View Inventory 
Transaction History 

INQHSTPR cp711_inqhstpr_007.zip 

Materials IN View Part Inventory INQPINV cp711_inqpinv_017.zip 

Materials IN Import Inventory 
Transactions 

AOPINTRN cp711_aopintrn_005.zip 

Materials  RC Enter Miscellaneous 
Inventory Receipts  

RCMMSRC cp711_rcmmsrc_012.zip 

Administration Domain 
This section includes summaries of the changes made in relation with the Organization Security feature within the 
Costpoint Administration domain. 

View Help About (SYMABOUT)  
The Features subtask on the View Help About (SYMABOUT) screen now includes the Organization Security feature for 
the Inventory module. 

Materials Domain 
This section includes summaries of changes made in relation with the Organization Security feature within the Costpoint 
Materials domain. 
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Configure Inventory Accounts (INMACCT)  
Costpoint now narrows the search and displays only organizations authorized for your logged-in user ID. If you enter an 
organization that you do not have full rights to, Costpoint displays the following error message: Your user ID does not 
have access to the Organization: [Org ID]. 

Configure Default Project Inventory Accounts (INMWACCT)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights for the project’s owning organization. 

 Lookup 

 Inventory Project — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. 

 Project Abbrev — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. 

 Organization — Costpoint now narrows the search and displays only organizations authorized for the 
logged-in user ID. 

 Data Entry — If organization security is enabled in the system settings, and the screen is activated for 
organization security, Costpoint will not allow you to enter or select records that your user ID does not have full 
rights to. Costpoint displays error messages for unauthorized entries. 

Manage Inventory Projects (INMPROJ)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights for the project’s owning organization. 

 Lookup 

 Inventory Project — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. 

 Project Abbrev — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. 

 Organization — Costpoint now narrows the search and displays only organizations authorized for the 
logged-in user ID. 

 A new field, Organization, has been added to the screen to display the owning organization of the inventory 
project. 

 Data Entry — If organization security is enabled in the system settings, and the screen is activated for 
organization security, Costpoint will not allow you to enter or select records that your user ID does not have full 
rights to. Costpoint displays error messages for unauthorized entries. 

Enter Scrap Adjustments (INMSCADJ)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights to the adjusting organization on the transaction. When your rights to the adjusting organization have been 
established, Costpoint displays all other information, regardless of your rights to associated projects and 
inventory abbreviations. 

 Lookup 
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 Organization — Costpoint now narrows the search and displays only organizations authorized for the 
logged-in user ID. In addition, Costpoint displays only organizations that the material handler and approver 
are authorized for when you do a lookup of material handler/approver project and organization. 

 Project — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the material handler 
and approver are authorized for when you do a lookup of material handler/approver project and 
organization. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with 
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only 
inventory abbreviations that the material handler and approver are authorized for when you do a lookup of 
material handler/approver project and organization. 

 New records — When you enter scrap inventory abbreviation, Costpoint defaults to the material account, 
material organization, and organization abbreviation in the scrap at the header level. In addition, Costpoint now 
saves the scrap organizations in the inventory transaction organization ID table. 

Enter Inventory Transfers (INMPAXFR)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights for the Inventory Abbrev in the To group box of the transaction header. When your rights to the scrap 
inventory abbreviation’s organization have been established, Costpoint displays all transaction lines, regardless 
of your rights to associated projects and inventory abbreviations. 

 Lookup 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with 
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only 
inventory abbreviations with projects and organizations that the material handler is authorized for when you 
do a lookup of material handler/approver project and organization. 

 Reservation — Costpoint now narrows the search and displays only reservations with organizations from 
the To group box authorized for the logged-in user ID.. 

 A new field, Organization, has been added to the screen to display the default value from the inventory 
abbreviation code. 

 New records — When you enter the Inv Abbrev in the To group box, Costpoint defaults to the material 
organization at the header level. In addition, Costpoint now saves organizations of the To group box in the 
inventory transaction table. 

Manage PO/Req Inventory Reservations (INMPORSV)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights to the buyer’s organization associated with the PO or the requisitioner’s organization associated with the 
requisition on the reservation header. When your rights have been established, Costpoint displays all 
reservation lines, regardless of your rights to associated projects and inventory abbreviations. 

 Lookup 

 PO/Rlse — Costpoint now narrows the search and displays only PO/Rlse records authorized for the logged-
in user ID. 

 Requisition — Costpoint now narrows the search and displays only requisition records authorized for the 
logged-in user ID. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with 
organizations and projects (owning organization) authorized for the logged-in user ID. In addition, Costpoint 
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displays only inventory abbreviations with projects and organizations that the requester is authorized for 
when you do a lookup of the requester. 

 A new field, Organization, has been added to the screen to display the default value from the purchase order 
(PO) line or requisition line. 

 A new field, Org Abbrev, has been added to the screen to display the default value from the inventory 
abbreviation code. 

 Data Entry — If organization security is enabled in the system settings, and the screen is activated for 
organization security, Costpoint will not allow you to enter or select POs or requisitions associated with the 
organizations that your user ID does not have full rights to. Costpoint displays error messages for unauthorized 
entries. 

Create Inventory Allocations (INPALLOC)  
The following are the changes to the lookup screen: 

 Manufacturing Order — Costpoint now narrows the search and displays only manufacturing orders (MOs) where 
the logged-in user ID is authorized for the planner’s organization ID. Costpoint will not display MOs without the 
planner’s organization ID. 

 Purchase Order — Costpoint now narrows the search and displays only POs where the logged-in user ID is 
authorized for the buyer’s organization ID. Costpoint will not display POs without the buyer’s organization ID. 

 Inventory Issues — Costpoint now narrows the search and displays only inventory issue records where the 
logged-in user ID is authorized for the To Organization. Costpoint will not display records with blank To 
Organization. 

 Inventory Transfer — Costpoint now narrows the search and displays only records where the logged-in user ID 
is authorized for the To Organization. Costpoint will not display records with blank To Organization. 

 Sales Order — Costpoint now narrows the search and displays only sales orders where the logged-in user ID is 
authorized for the sales order organization ID. Costpoint will not display records with blank sales order 
organization ID. 

 Costpoint will not create allocations to the transactions where the logged-in user is not authorized for, or where 
the reference organization IDs are left blank. 

Enter Issues to Project/Account/Org or PO (INMPAISS)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights for the To Organization, or the PO/Rlse buyer organization in the To group box of the transaction header. 
When your rights to the header organization ID have been established, Costpoint displays all transaction lines, 
regardless of your rights to associated projects and organization rights associated with the From Inv Abbrev at 
the line level. 

 Lookup 

 Organization — Costpoint now narrows the search and displays only organizations authorized for the 
logged-in user ID. In addition, Costpoint displays only organizations that the material handler is authorized 
for when you do a lookup of material handler project and organization. 

 Project — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the material handler is 
authorized for when you do a lookup of material handler project and organization. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with 
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only 
inventory abbreviations that the material handler is authorized for when you do a lookup of material handler 
project and organization. 
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 New records (Issue Type=Issue to Project/Account) — When you enter To Expense Inv Abbrev, Costpoint 
defaults to the material organization and organization abbreviation at the header level. In addition, Costpoint 
now saves organizations of the To group box in the inventory transaction table. 

 New records (Issue Type=Issue to Purchase Order) — When you enter PO/Rlse and line, Costpoint defaults to 
the PO line inventory abbreviation in the To Expense Inv Abbrev and its associated projects in the To Project. 
In addition, Costpoint now saves organizations of the To group box in the inventory transaction table. 

Enter Cost Adjustments (INMCSADJ)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights for the part to adjust the inventory abbreviation’s organization. When your rights to the header 
organization ID have been established, Costpoint displays all transaction lines, regardless of your rights to 
associated projects and organization rights associated with the part to adjust the inventory abbreviation’s 
organization. 

 Lookup 

 Organization — Costpoint now narrows the search and displays only organizations authorized for the 
logged-in user ID. In addition, Costpoint displays only organizations that the adjuster and approver is 
authorized for when you do a lookup of adjuster/approver project and organization. 

 Project — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the adjuster and 
approver is authorized for when you do a lookup of adjuster/approver project and organization. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with 
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only 
inventory abbreviation that the adjuster and approver is authorized for when you do a lookup of 
adjuster/approver project and organization. 

 A new field, Organization, has been added to the screen. Use this field to enter the organization to be charged 
for this adjustment. 

 A new field, Org Abbrev, has been added to the screen. Use this field to enter the organization abbreviation ID 
to be charged for this adjustment. 

 New records — When you enter a part to adjust inventory abbreviation, Costpoint defaults to the material 
organization and organization abbreviation at the header level. In addition, Costpoint now saves organizations of 
the To group box in the inventory transaction table. 

Enter Quantity Adjustments (INMQTADJ)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights for the adjusting inventory abbreviation’s organization. When your rights to the adjusting inventory 
abbreviation’s organization have been established, Costpoint displays all transaction lines, regardless of your 
rights to associated projects and organizations. 

 Lookup 

 Organization — Costpoint now narrows the search and displays only organizations authorized for the 
logged-in user ID. In addition, Costpoint displays only organizations that the material handler and approver 
are authorized for when you do a lookup of an organization. 

 Project — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the material handler 
and approver are authorized for when you do a lookup of a project. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with 
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only 
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inventory abbreviations that the material handler and approver are authorized for when you do a lookup of 
an inventory abbreviation. 

 New records — When you enter an adjusting inventory abbreviation, Costpoint defaults to the material 
organization and organization abbreviation at the header level. In addition, Costpoint now saves the adjusting 
organization ID in the inventory transaction table. 

Enter Location Transfers (INMLOXFR)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights for the material handler’s organization. When your rights to the material handler’s organization have been 
established, Costpoint displays all transaction lines, regardless of your rights to associated projects and 
organizations. 

 Lookup — Costpoint now narrows the search and displays only inventory abbreviations with projects and 
organizations authorized for the logged-in user ID. In addition, Costpoint displays only projects and 
organizations that the material handler is authorized for when you do a lookup of an inventory abbreviation. 

 New records — When you enter a material handler, Costpoint defaults to the material organization at the header 
level on the Employee Salary Information (LDMEHIS) screen. In addition, Costpoint now saves the material 
hander’s organization in the inventory transaction table. 

Create Mass Inventory Transfers (INPMSXFR)  
The following are the changes to this screen: 

 Lookup — Costpoint now narrows the search and displays only inventory abbreviations with project owning 
organizations and organizations authorized for the logged-in user ID. In addition, Costpoint displays only 
inventory abbreviations with projects and organizations that the material handler is authorized for when you do a 
lookup of an inventory abbreviation. 

 Costpoint now saves the material organization linked to the To Inv Abbrev in the inventory transaction table. 

Manage Inventory Requests (INMRQST)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights for the To Inv Abbrev organization or To Organization on the request header. When your rights to the 
To Inv Abbrev organization or To Organization have been established, Costpoint displays all transaction lines, 
regardless of your rights to associated projects and organizations associated with the From Inv Abbrev at the 
line level. 

 Lookup 

 Organization — Costpoint now narrows the search and displays only organizations authorized for the 
logged-in user ID. In addition, Costpoint displays only organizations that the requester is authorized for 
when you do a lookup of an organization. 

 Project — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the requester is 
authorized for when you do a lookup of a project. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with 
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only 
inventory abbreviations with projects and organizations that the requester is authorized for when you do a 
lookup of an inventory abbreviation. 

 New records — When you enter To Inv Abbrev, Costpoint defaults to the material account, material 
organization, and organization abbreviation at the header level. 
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Manage Inventory Reservations (INMPARSV)  
The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights to the To Organization on the reservation header. When your rights to the or To Organization have 
been established, Costpoint displays all transaction lines, regardless of your rights to associated projects and 
organizations associated with the From Inv Abbrev at the line level. 

 Lookup 

 Organization — Costpoint now narrows the search and displays only organizations authorized for the 
logged-in user ID. In addition, Costpoint displays only organizations that the requester is authorized for 
when you do a lookup of an organization. 

 Project — Costpoint now narrows the search and displays only projects with owning organizations 
authorized for the logged-in user ID. In addition, Costpoint displays only projects that the requester is 
authorized for when you do a lookup of a project. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations with 
organizations and projects authorized for the logged-in user ID. In addition, Costpoint displays only 
inventory abbreviations with projects and organizations that the requester if authorized for when you do a 
lookup of an inventory abbreviation. 

 New records — When you enter To Inv Abbrev, Costpoint defaults to the material account, material 
organization, and organization abbreviation at the header level. 

Print Purchase Price Variance Analysis Report (INRPPV)  
When you select Print Options - Standard Costing, Costpoint will not print the purchase order (PO) price variance details 
by project/PO if logged-in user ID is not authorized for the PO buyer organization, and Costpoint will instead display the 
following message: PO Variance not printed - Your user ID is not authorized for the PO Buyer Org. 

Create Purchase Price Variance Journal Entry (INPPPV)  
When you select Print/Preview/Create, Costpoint processes all records but detailed report will only be displayed for 
purchase orders (PO) with buyer organization that the logged-in user ID is authorized for. 

Print Inventory Reorder Report (INPREORD)  
The following are the changes to this screen: 

 Lookup — Costpoint now narrows the search and displays only projects with owning organizations authorized 
for the logged-in user ID. 

 Report — Costpoint now validates header project against the logged-in user ID if One or Range is selected as 
an option, and reports are printed by project. 

Print Inventory Transaction History (INRHSTPA)  
If organization security is enabled in the system settings, and the screen is activated for organization security, Costpoint 
will not allow you to select records that your user ID does not have full rights to. Costpoint displays an error message for 
unauthorized entries. 

The transaction type indicated in the inventory transaction and your logged-in user ID authorization determine the 
records that Costpoint allows you access to. 

Costpoint will allow you access to records from the inventory transaction table with the following transaction types and 
logged-in user ID authorization combination: 

Transaction Type User ID Authorized for 

Issue to Project/Account  To Organization  

Issue to Purchase Order To Organization  
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Transaction Type User ID Authorized for 

Quantity Adjustment  Adjusting Org  

Scrap Adjustment Adjusting Org  

Cost Adjustment Part to Adjust Inv Abbrev’s Org  

Project/Account Transfer Organization 

Location Transfer Material Handler’s Org 

Miscellaneous Receipt Material Handler’s Org 

Load Organization IDs (INPLDORG)  
Use this new screen (Materials » Inventory » Inventory Utilities » Load Organization IDs) to load or default material 
handler’s organizations for miscellaneous receipts and location transfer IDs. This utility automatically runs in the 
backend to populate the inventory transaction table for the other inventory transaction types such as Issue to Purchase 
Order (ISSUEPO), Issue to Manufacturing Order (ISSUEMO), Quantity Adjustment (ADJQTY), Cost Adjustment 
(ADJCST), Scrap Adjustment (ADJSCRAP), Project/Account Transfer (TRNFPAO), PO Receipt (TRNFRCPT). It 
populates either the owning organization linked to the project or the material organization linked to the inventory 
abbreviation associated with the inventory transaction. 

View Inventory Transaction History (INQHSTPR)  
Costpoint now narrows the search and displays only inventory transactions with organizations authorized for the logged-
in user ID. 

View Part Inventory (INQPINV)  
Costpoint now narrows the search and displays only projects for which you want to do an inventory with organizations 
authorized for the logged-in user ID. In addition, Costpoint now narrows the search and displays only projects with 
owning organizations authorized for the logged-in user ID. 

Import Inventory Transactions (AOPINTRN)  
Costpoint now loads/populates values in the inventory transaction table. 

Enter Miscellaneous Inventory Receipts (RCMMSRC)  
The following are the changes to this screen: 

 A new field, Organization, has been added to the screen. Use this field to enter the material handler 
employee’s organization ID. 

 Data Entry — If organization security is enabled in the system settings, and the screen is activated for 
organization security, Costpoint will not allow you to enter or select records that your user ID does not have full 
rights to. Costpoint displays error messages for unauthorized entries. 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s organization 
rights. 

INMRQSTLIB Library 
The INMRQSTLIB library contains common business logic, which is shared by the following applications: 

 Manage Inventory Reservations (INMPARSV) 

 Manage Inventory Requests (INMRQST) 

System Requirements 
This enhancement requires the following: 
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 cp711_cmnlib_INMRQSTLIB_001.zip 

 cp711_sys_043.zip 

INMADJLIB Library 
The INMADJLIB library contains common business logic, which is shared by the following applications: 

 Enter Quantity Adjustments (INMQTADJ) 

 Enter Scrap Adjustments (INMSCADJ) 

System Requirements 
This enhancement requires the following: 

 cp711_cmnlib_INMADJLIB_001.zip 

 cp711_sys_043.zip 

Administration 
There are no changes to the Administration domain for this release. 

Reports & Analytics 
Role-Based Dashboards: Limitation on the Number of Dashparts Displayed 
The number of dashparts that display on the Dashboard Reports tab depends on the number of dashparts you have 
open on the Parameters tab and your screen resolution. For example, if your screen resolution is lower than 1680 pixels, 
not all eight dashparts opened on the Parameters tab will be displayed on the Reports tab. 

As a workaround, you can do any of the following: 

 Toggle between the Parameters and Reports tabs to add (open) and remove (close) dashparts that you want to 
view.  

 Drag the dashpart table windows up or down on the Parameters tab to rearrange the dashparts. Costpoint 
displays the dashparts on the Reports tab in the order that they appear on the Parameters tab, first to last. 

 Set your screen resolution to 1920 pixels, which is the recommended resolution to view all dashparts. Note, 
however, that if your screen does not support 1920 pixels, you will not be able to set that resolution. 

Costpoint Integration 
Deltek Talent Management Integration Enhancements 
This Costpoint release provides the following enhancements to Costpoint - Deltek Talent Management integration:  

 Automatically assign employee IDs and accept partial employee records  

 Onboarding of rehired employees  

 Populate the Last Day Worked field based on the termination date 

Pre-Installation Information 
This enhancement requires the following Costpoint 7.1.1 releases:  

 System JAR 037  

 PATCH3321  

 PATCH3218  
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 PATCH3224  

 PATCH3454  

 PATCH3457  

Application JAR Requirements 
The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR version for 
each application, if applicable. 

Domain Module Application ID Application 
Name 

Application Files 

Administration System 
Administration 

SYPCOMP Set Up Company cp711_sypcomp_021.zip 

People  Employee  AOPUTLEL  Import Employee 
Data  

cp711_aoputlel_016.zip  

People  Employee  EMMIDDEFAULT  Manage 
Employee 
Defaulting Rules  

cp711_emmiddefault_001.zip  

People  Employee  EMMIDFORMAT  Manage 
Employee ID 
Formats  

cp711_emmidformat_001.zip  

People  Employee  EMPHRSDAT  Transfer Talent 
Management 
Data  

cp711_emphrsdat_015.zip  

People  Employee  EMPTMUI  Link Talent 
Management 
User IDs to 
Existing 
Employees  

cp711_emptmui_001.zip  

People  Employee  LDMEINFO  Manage 
Employee 
Information  

cp711_ldmeinfo_022.zip  

People  Labor  LDMLABOR  Configure Labor 
Settings  

cp711_ldmlabor_008.zip  

People  Payroll  PRQEINFO  View Employee 
Information  

cp711_prqeinfo_005.zip 

 

Automatically Assign Employee ID and Import Partial Employee Records 
This release provides the ability to auto-generate employee IDs in Costpoint. If you use Deltek Talent Management, you 
can now import employee records that do not have employee ID values and allow Costpoint to auto-generate the IDs. 
The auto-generate employee ID function is available to all Costpoint users when manually entering an employee record. 
Only Deltek Talent Management users may import employees without employee IDs and have them auto generated. 
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Warning: If you use Deltek Talent Management; after you download this feature from DSM, you must perform the 
applicable procedure in the Initialize Talent Management HUA ID-to-Costpoint Employee ID Mapping section. 
Otherwise, the integration process between Costpoint and Deltek Talent Management will no longer function. 

Configure Labor Settings (LDMLABOR)  

 The Employee Options tab contains a new Auto-Generate Employee IDs check box enables the functionality 
to automatically generate IDs for new employees. This check box displays as selected and disabled if you select 
the Auto-Generate Employee IDs for All Companies check box on the Corporate Labor Settings subtask. 
This functionality is currently only available for Deltek Talent Management users.  

 The Corporate Labor Settings subtask contains a new Auto-Generate Employee IDs for All Companies check 
box. Select this check box to enable Costpoint to automatically generate new employee IDs for companies 
within the corporation.  

Import Employee Data (AOPUTLEL)  
If you select the Auto-Generate Employee IDs check box on the Configure Labor Settings screen, the following error 
message displays when you attempt to open the Import Employee Data screen: “When auto-generation of employee IDs 
is enabled in your company’s Configure Labor Setting screen, you may not import any new employee IDs.”  

Link Talent Management User IDs to Existing Employees (EMPTMUI)  
When you run this new toolkit, it will populate the Costpoint Employee (EMPL) table with each applicable employee’s 
Deltek Talent Management user ID (HUA ID). It will also set the Active HUA ID Mapping flag which indicates whether 
the Costpoint Employee has an active or inactive mapping to the HUA ID. 

Attention: The timing of this toolkit depends on whether you’re an existing Costpoint 7.1.1 user, an existing Deltek 
Talent Management user, an existing client for both Costpoint 7.1.1 and Deltek Talent Management, or a new user for 
both products.  

You must run this toolkit after installing the Auto-Assign Employee IDs feature and before importing or exporting 
employees in the Transfer Talent Management Data screen. Running this toolkit will populate the Deltek Talent 
Management HUA ID (HUA_ID) and Active HUA ID Mapping (HUA_ACTV_MAP_FL) columns in the Manage Employee 
Information (EMPL) table.  

For detailed steps on using this toolkit, please refer to the Talent Management HUA ID-to-Costpoint Employee ID 
Mapping Initialization Scenarios section. 

Manage Employee ID Defaulting Rules (EMMIDDEFAULT)  
Use the new Manage Employee Defaulting Rules screen to enter and manage defaulting rules for your employee ID 
format codes.  

Note: You can access the Manage Employee ID Defaulting Rules screen only if you select the Auto-Generate 
Employee IDs check box on the Configure Labor Settings screen. Otherwise, an error will display when you attempt to 
open the application. 

You must establish employee ID defaulting rules in the following scenarios:  

 If you selected the Auto-Generate Employee IDs check box on the Configure Labor Settings screen for 
companies, you must establish employee ID defaulting rules for each of company that has this labor setup.  

 If you selected the Auto-Generate Employee IDs for All Companies check box on the Corporate Labor 
Settings subtask of the Configure Labor Settings screen, you must establish at least one defaulting rule for all 
companies or you can establish defaulting rules for each company.  
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To launch the screen, go to the People » Employee » Employee Controls menu. 

Manage Employee ID Formats (EMMIDFORMAT)  
Use the new Manage Employee ID Formats screen you to establish the formatting of employee IDs. Costpoint will use 
this format when you opt to auto-generate the employee IDs.  

Note: You can access the Manage Employee ID Formats screen only if you select the Auto-Generate Employee IDs 
check box on the Configure Labor Settings screen. Otherwise, an error will display when you attempt to open the 
application.  

To launch the screen, go to the People » Employee » Employee Controls menu. 

Manage Employee Information (LDMEINFO)  
The following are updates on the Manage Employee Information screen:  

 A new HUA ID field allows you to enter the Talent Management user ID for the employee. The application uses 
this field to map Costpoint employee IDs to Deltek Talent Management user IDs when you import employee 
data into Costpoint.  

 A new Talent Management Active HUA ID Mapping check box indicates whether or not the specified HUA ID 
is actively mapped to the Costpoint employee. If this check box displays as selected, the Transfer Talent 
Management Data application uses the specified HUA ID to determine whether or not the employee is a rehire.  

 The application performs a validation to check the staging database tables when an adding an employee.  

Print Data Dictionary Report  
The Print Data Dictionary Report application now provides information for the following new columns on the Employee 
(EMPL) table:  

 HUA_ACTV_MAP_FL — Flag that indicates if the employee's HUA ID is active.  

 HUA ID — HUA ID sent from Talent Management. 

Set Up Company (SYPCOMP)  
When you create a new company, the application populates the EMPL_ID_AUTOGEN_FL column in the 
LAB_SETTINGS database based on the values of the company being copied.  

Transfer Talent Management Data (EMPHRSDAT)  

 When you run the Transfer Talent Management Data process, the application generates employee IDs for 
imported Deltek Talent Management employee records without IDs.  

 The application adds employee records to staging database tables if the Deltek Talent Management records are 
missing any required fields. The application will not add records to staging database tables if the employee ID is 
missing and auto-generation of employee IDs is not enabled.  

 The application performs validations to ensure that the imported file from Deltek Talent Management contains all 
fields required to generate an employee ID. The application will not add records to the staging database tables if 
it could not generate an employee ID.  

 The application removes the employee records from the staging database tables once a complete employee 
record is sent from Deltek Talent Management.  

 The application uses the following staging database tables:  

 EMPL_STG  

 EMPL_PHONE_STG  

 EMPL_LAB_INFO_STG  
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 DFLT_REG_TS_STG  

 EMPL_TAX_STG  

View Employee Information (PRQEINFO)  
The screen contains new a HUA ID field and a Talent Management Active HUA ID Mapping check box. These display 
the information from the same fields on the Manage Employee Information screen. 

Onboarding of Rehired Employees 
This feature provides the ability to include rehires when importing employees that have completed the onboarding 
process in Deltek Talent Management. Importing of an existing Costpoint employee ID that was rehired to a different 
company is not supported at this time.  

Manage Employee Information (LDMEINFO)  
The application was updated to support the processing of rehired employee records that were imported from Deltek 
Talent Management to Costpoint through the Transfer Talent Management Data process. 

Transfer Talent Management Data (EMPHRSDAT)  
The following are the updates to the Transfer Talent Management Data screen for the onboarding of rehires:  

 The application process can now identify new hires and rehires. It also determines and identifies when a new 
employee record needs to be generated or if an existing record will be updated.  

 When exporting employees, the application will not include employee records that does not have an active 
mapping to a HUA ID (Talent Management User ID). An employee record does not have an active mapping if 
the HUA_ID_ACTV_AP_FL column is N. 

 When importing rehires, if the employee record in Costpoint indicates that the employee is still employed (either 
the Termination Date field is blank or the Termination Date value is later than the rehire date), an error will be 
logged, and the rehired employee will not be imported.  

Populate the Last Day Worked Field Based on the Termination Date  
When you enter a value in the Termination Date field on the Manage Employee Information screen, the screen displays 
a warning message which provides you the option to populate the Last Day Worked field with the date that you entered 
in the Termination Date field. If you decline the option to auto-populate the Last Day Worked field, you must manually 
enter a date in the Last Day Worked field before saving the record.  

Existing termination records will not be affected by this update and the warning message will only display for future 
termination records. 

Initialize Talent Management HUA ID-to-Costpoint Employee ID Mapping  
Before you use Costpoint’s Auto-Assign Employee ID feature, you must run the Link Talent Management User IDs to 
Existing Employees (EMPTMUI) toolkit based on your current Costpoint/Deltek Talent Management setup.  

You must run the Link Talent Management User IDs to Existing Employees toolkit after downloading the Auto-Assign 
Employee IDs feature and before importing or exporting employees in the Transfer Talent Management Data screen. 
Running this toolkit will populate the HUA ID and Active HUA ID Mapping columns in the Manage Employee Information 
table (EMPL.HUA_ID and EMPL.HUA_ACTV_MAP_FL). 

Scenarios  
Refer to the following scenarios and perform the corresponding steps that apply to your company’s setup:  

Scenario 1  
You currently use both products, Costpoint 7.1.1 and Deltek Talent Management, and you installed Costpoint’s 
Auto-Assign Employee ID feature which was released in June 2018. 
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Step Product Details 

1  Deltek Talent Management  Generate the export_user_id_file file in Deltek Talent Management’s 
Administration » Global Settings » Integration Setup » Costpoint » 
Costpoint Configuration Check screen. This file maps the Talent Management 
user IDs (HUA IDs) to the Costpoint Employee IDs.  

2  Costpoint  Use the export_user_id_file file you just generated in Deltek Talent 
Management to run the People » Employee » Employee Utilities » Link 
Talent Management User IDs to Existing Employees toolkit. You must 
complete this step before you will be able to import new users from Deltek 
Talent Management.  

3 Costpoint Determine if you want to allow Costpoint to auto generate employee IDs. 

Warning: If you choose to auto-generate employee IDs, you will not be able to 
use Costpoint’s Import Employee Data application to import employees using a 
data file.  

 If you would like Costpoint to auto-generate Employee IDs for new hires 
that come from Deltek Talent Management, proceed to Step 4. 

 If you do not want Costpoint to auto-generate Employee IDs for new 
hires that come from Deltek Talent Management, you have completed 
the required steps and are ready to start importing new hires from 
Deltek Talent Management.  

4  Costpoint  Go to People » Labor » Labor Controls » Configure Labor Settings screen, 
select the Auto-Generate Employee IDs check box, and then save the record.  

5  Costpoint  Go to Administration » System Administration » System Administration 
Utilities » Rebuild Global Settings screen, select the Labor option in the 
Individual Settings group box, and then run the application process. 

 

Scenario 2  
You currently use Deltek Talent Management and you purchased Costpoint version 7.1.1 after May 2018. 

Step Product Details 

1  Costpoint  Go to People » Labor » Labor Controls » Configure Labor Settings screen, 
and ensure that the Auto-Generate Employee IDs check box is not selected.  

Note: If the Auto-Generate Employee IDs check box is selected, clear the check 
box. After saving your changes, go to the Rebuild Global Settings screen, select 
the Labor option in the Individual Settings group box, and then run the 
application process.  

2  Costpoint  Create employee records in Costpoint. You can create employee records by 
performing either of the following methods:  

 Entering employee records on People » Employee » Basic Employee 
Information » Manage Employee Information screen  
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Step Product Details 

 Importing an employee file on People » Employee » Employee 
Interfaces » Import Employee Data screen.  

3  Deltek Talent Management  Manually assign the newly created Costpoint employee IDs to your existing 
Talent Management users.  

4  Deltek Talent Management  Generate the export_user_id_file file in Deltek Talent Management’s 
Administration » Global Settings » Integration Setup » Costpoint » 
Costpoint Configuration Check screen. This file maps the Talent Management 
user IDs (HUA IDs) to the Costpoint Employee IDs.  

5  Costpoint  Use the export_user_id_file file you just generated in Deltek Talent 
Management to run the People » Employee » Employee Utilities » Link 
Talent Management User IDs to Existing Employees toolkit. You must 
complete this step before you will be able to import new users from Deltek 
Talent Management.  

6  Costpoint  Determine if you want to allow Costpoint to auto generate employee IDs.  

Warning: If you choose to auto-generate employee IDs, you will not be able to 
use Costpoint’s Import Employee Data application to import employees using a 
data file.  

 If you would like Costpoint to auto-generate Employee IDs for new hires 
that come from Deltek Talent Management, proceed to Step 4.  

 If you do not want Costpoint to auto-generate Employee IDs for new 
hires that come from Deltek Talent Management, you have completed 
the required steps and are ready to start importing new hires from 
Deltek Talent Management. 

7  Costpoint  Go to People » Labor » Labor Controls » Configure Labor Settings screen, 
select the Auto-Generate Employee IDs check box, and then save the record.  

8  Costpoint  Go to Administration » System Administration » System Administration 
Utilities » Rebuild Global Settings, select the Labor option in the Individual 
Settings group box, and then run the application process. 

 

Scenario 3  
You currently use Costpoint 7.1.1 and you purchased Deltek Talent Management after May 2018. 

Step Product Details 

1  Costpoint  Go to People » Employee » Employee Interface » Transfer Talent 
Management Data screen, and run a full export of the following:  

 Employees  

 Organizations  

 Job Templates  

 Detail Job Titles  

 Labor Locations  
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Note: You may opt to exclude employees that were terminated before a specific 
date.  

2  Deltek Talent 
Management  

Generate the export_user_id_file file in Deltek Talent Management’s 
Administration » Global Settings » Integration Setup » Costpoint » 
Costpoint Configuration Check screen. This file maps the Talent Management 
user IDs (HUA IDs) to the Costpoint Employee IDs.  

3  Costpoint  Use the export_user_id_file file you just generated in Deltek Talent 
Management to run the Link Talent Management User IDs to Existing 
Employees toolkit. You must complete this step before you will be able to import 
new users from Deltek Talent Management.  

4  Costpoint  Determine if you want to allow Costpoint to auto generate employee IDs.  

Warning: If you choose to auto-generate employee IDs, you will not be able to 
use Costpoint’s Import Employee Data application to import employees using a 
data file.  

 If you would like Costpoint to auto-generate Employee IDs for new hires 
that come from Deltek Talent Management, proceed to Step 5.  

 If you do not want Costpoint to auto-generate Employee IDs for new 
hires that come from Deltek Talent Management, you have completed 
the required steps and are ready to start importing new hires from Deltek 
Talent Management.  

5  Costpoint  Go to People » Labor » Labor Controls » Configure Labor Settings screen, 
select the Auto-Generate Employee IDs check box, and then save the record.  

6  Costpoint  Go to Administration » System Administration » System Administration 
Utilities » Rebuild Global Settings screen, select the Labor option in the 
Individual Settings group box, and then run the application process. 

 

Scenario 4  
You purchased both products, Costpoint 7.1.1 and Deltek Talent Management, after May 2018. 

Step Product Details 

1  Costpoint  Create employee records in Costpoint. You can create employee records by 
performing either of the following methods:  

Entering employee records on People » Employee » Basic Employee 
Information » Manage Employee Information screen  
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Step Product Details 

Importing an employee file on People » Employee » Employee Interfaces » 
Import Employee Data screen.  

2  Costpoint  Go to People » Employee » Employee Interface » Transfer Talent 
Management Data screen, and run a full export of the following:  

 Employees  

 Organizations  

 Job Templates  

 Detail Job Titles  

 Labor Locations  

3  Deltek Talent 
Management  

Generate the export_user_id_file file in Deltek Talent Management’s 
Administration » Global Settings » Integration Setup » Costpoint » 
Costpoint Configuration Check screen. This file maps the Talent 
Management user IDs (HUA IDs) to the Costpoint Employee IDs.  

4  Costpoint  Use the export_user_id_file file you just generated in Deltek Talent 
Management to run the Link Talent Management User IDs to Existing 
Employees toolkit. You must complete this step before you will be able to 
import new users from Deltek Talent Management.  

5  Costpoint  Determine if you want to allow Costpoint to auto generate employee IDs.  

Warning: If you choose to auto-generate employee IDs, you will not be able to 
use Costpoint’s Import Employee Data application to import employees using a 
data file.  

 If you would like Costpoint to auto-generate Employee IDs for new 
hires that come from Deltek Talent Management, proceed to Step 6.  

 If you do not want Costpoint to auto-generate Employee IDs for new 
hires that come from Deltek Talent Management, you have completed 
the required steps and are ready to start importing new hires from 
Deltek Talent Management. 

6  Costpoint  Go to People » Labor » Labor Controls » Configure Labor Settings screen, 
select the Auto-Generate Employee IDs check box, and then save the record.  

7  Costpoint  Go to Administration » System Administration » System Administration 
Utilities » Rebuild Global Settings screen, select the Labor option in the 
Individual Settings group box, and then run the application process. 

 

Errors  
All warnings and errors are written to a log file (EMPTMUI_yymmddhhTms.log). The log file will be saved in the location 
that you specified in the File Location field of the Link Talent Management User IDs to Existing Employees toolkit. If a 
location has not been specified, warnings and errors will be written to the database and you can retrieve it from the File 
Download (SYMDLMGR) screen. 

Known Issues  



Costpoint 

Cumulative Release Notes for July 2018 29 

 

Employees not Terminated in Costpoint were Processed as a Rehire  
Deltek Defect Tracking Number: 963051  

Description: When the Talent Management Active HUA ID Mapping column contains a value of No and the 
employee has not been terminated in Costpoint, the Transfer Talent Management Data screen still allows you to 
successfully import a rehired employee record into Costpoint.  

Regardless of the value of Talent Management Active HUA ID Mapping column, the processing of rehires should not 
be successful if the Costpoint employee record has no termination date.  

Customers Impacted: This defect affects Costpoint - Deltek Talent Management Integration users.  

Workaround Before Fix: None.  

Additional Notes: The application performs a validation only if the employee has both a termination date and an active 
HUA ID mapping. The HUA ID mapping must be active if there is no termination date as of the Deltek Talent 
Management hire date. 
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Budgeting and Planning 
Budgeting Administration 
Project Security Options Expanded 
A Project Security to be Based On option was added to the Project tab of the Configuration Settings (MAM10) screen. 
Options include Org ID or Project Budget Security. 

 
Prior to this enhancement, project security was automatically based on Org ID, which is still the default setting.  

This configuration setting was primarily added to support the forthcoming Maintain Project Budget Security screen 
that is scheduled for release in August 2018. The new screen will enable Project Budget Accountants to separate 
Project Budget Creators and Project Budget Approvers similar to Org Budgeting.  

Switching this setting to Project Budget Security allows Project Managers to view and edit all assigned budgets. If 
security is based on Org ID, and for example, a Project manager has a Home Org of an Overhead type, he or she could 
not edit project budgets and associated resources that have a Direct type of Home Org, such as Engineering or 
Construction. 

Requirements 

The enhancement requires:  

cp711_bp_bnp_bammam10_009.zip  

cp711_bnp_common_007.zip 
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Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domai
n 

Module » Application 
Group 

Application ID Application 
Name 

Application File 

Admin Budgeting 
Administration » 
Administration Controls 

BNP_BAMPBA Maintain 
Project 
Budget 
Security 

cp711_bp_bnp_bammam10_009.
zip 
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Time and Expense 
Time 
There are no updates in this area. 

Expense 
Enhancement 
Expense Authorization Attachment Subtask Conversion 

This enhancement was applied to Manage Expense Authorization and Manage/Approve Expense Authorizations. 

Expense Report Attachment Subtask Conversion 
To improve usability, the Attachment subtask in Manage Expense Report and Manage/Approve Expense Reports was 
converted to a tab. This change also supports the upcoming Expense Wizard, scheduled for release later in 2018. 

To improve usability, the Attachment subtask in Manage Expense Authorization and Manage/Approve Expense 
Authorizations was converted to a tab.   

 
Prior to this change, the Attachments displayed as subtask link, as shown below: 
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Prior to this change, the Attachments displayed as subtask link, as shown below: 

 
This enhancement was applied to Manage Expense Report and Manage/Approve Expense Reports. 

Configuration 
There are no updates in this area. 

 



 

 

 

Deltek is the leading global provider of enterprise software and information solutions for government 
contractors, professional services firms and other project- and people-based businesses. For decades, we 
have delivered actionable insight that empowers our customers to unlock their business potential. 20,000 
organizations and millions of users in over 80 countries around the world rely on Deltek to research and identify 
opportunities, win new business, recruit and develop talent, optimize resources, streamline operations and deliver 
more profitable projects. Deltek – Know more. Do more.® 

deltek.com 
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